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CHAPTER 1 General Information 
 

 
 
 
 
 

1.1 Introduction to the EFR user guide 
 

The EFR User Guide supplies political entities with the knowledge and technical 
support to complete a financial return using the Electronic Financial Return 
(EFR) software. The guide aims to outline various functions of the software as 
well as to address some troubleshooting issues. 

 

 
Contents 

The EFR User Guide contains the following information: 
 

• how to obtain, install and update the EFR software 

• how to navigate the software 

• how to create and edit events and returns 

• how to enter cash inflows and outflows 

• how to submit an electronic financial return 

• how to troubleshoot 
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1.2 Contact information 
 
 
 

Online www.elections.ca 

Telephone Political Financing Support Network 
1-800-486-6563 

 

Regular Hours 
Monday to Friday, 9:00 a.m. to 5:00 p.m. (Eastern Time) 

 

Extended Hours 
Notifications regarding extended hours will be sent before 

reporting deadlines and electoral periods. 
 

Elections Canada General Inquiries 
1-800-INFO-VOTE 

(1-800-463-6868) 

Fax Political Financing 
1-888-523-9333 (toll free) 

Mail Elections Canada 
257 Slater Street 
Ottawa, Ontario 
K1A 0M6 

E-mail General Inquiries 
info@elections.ca 

 

Political Financing Inquiries 
political.financing@elections.ca 

 

EFR Inquiries 
efr-rfe@elections.ca 

 

 
 
 
 
 
 
 

  

http://www.elections.ca/
mailto:info@elections.ca
mailto:political.financing@elections.ca
mailto:efr-rfe@elections.ca
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1.3 Supporting documents - financial forms 
 

Supporting documents such as financial forms, registrations forms and 
manuals are located as follows: 

 

Elections Canada 

Website 

1. Visit www.elections.ca. 
2. Select the language of your choice. 
3. Click “Political Participants”. 
4. Select your political entity: “Tools for …”. 

5. Select “Financial Forms”, “Registration Forms” or 
“Manuals”. 

Multimedia USB Key Election Financing Documents 

Phone Call the Political Financing Support Network at 

1-800-486-6563 to request forms. 

 

 
 
 
 
  

http://www.elections.ca/
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CHAPTER 2 Software Management 
 

 
 
 
 
 
 

2.1 Obtain EFR software 
 

EFR is accessible via three methods: 
 

1. Multimedia USB key — A copy of the EFR software is included in the 
multimedia USB key distributed by Elections Canada. 

2. Website — Send an e-mail request to efr-rfe@elections.ca and include 
your name, role (candidate, official agent, financial agent, etc.) and 
political affiliation. A link will then be provided allowing you to download 
the EFR software from the Elections Canada website. 

3. By phone — Call the Political Financing Support Network at 1-800-486-
6563 to request a copy of the EFR software. 

 

 
 
 

2.2 Supported platforms 
 

EFR can be installed on most Microsoft operating systems: Windows XP, 
Windows NT, Windows ME, Windows 2000, Windows Vista and Windows 7 are 
the most commonly used. 

 
Macintosh users can install EFR but only through a virtual Windows 
environment. To install EFR on a Macintosh, the computer requires a: 

 

Power PC Chip 
 

1. Install Microsoft Virtual PC. 

2. Install Windows 2000/XP on the virtual machine. 

3. Install EFR.  

OR 

Intel Chip 
 

1.   Install Windows 2000/XP/Vista or Windows 7 through Boot Camp (available 
at www.apple.com) or on a virtual machine. 

 

Note: Elections Canada does not provide technical support for Macintosh users. 
 
 
 
  

mailto:efr-rfe@elections.ca
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2.3 Install EFR 
 

To install EFR: 
 

1. Locate and double-click the setup.exe file. 

2. Enter the installation password. All passwords are supplied with the 

software. 
If you do not have the password, call the Political Financing Support 
Network at 1-800-486-6563. 

3. The Select Destination Location window will appear. The default 
path is C:\Program Files\EFR\ 

4. The Document Directory Location window will appear. All financial returns 
are saved in the same folder. The default path for all documents stored by 
EFR is: 

 

For Windows 2000 and Windows XP 
C:\Documents and Settings\All Users\Shared Documents\EFR\ 

 

For Windows Vista and Windows 7 
C:\Users\Public\Documents\EFR\ 

 
5. Click “OK” to complete the installation. 

6. The EFR software icon will appear on your desktop. 

7. Double-click the EFR icon to start the program. 
 

 
 
 
Note: It is strongly recommended that you install EFR in the default location. If you 

wish to change the directory, make note of the change. 
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2.4 Check version 
 

Older versions of EFR do not reflect the current political financing legislation. It 
is therefore important to use the newest version of EFR when preparing a 
financial return. 

 

To verify the version number: 
 

1. Start EFR. 

2. Check the version number displayed in the title bar of the main window. 

 

 

OR 
 

1. Start EFR. 

2. Click the Help menu. 

3. Select “About”. 

4. Check the version number displayed in the window. 

5. Click “OK” to close the window. 
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2.5 Update EFR 
 

The EFR software is regularly updated. New versions are available for 

download on the Elections Canada website. To check if a new version of EFR is 

available, refer to the directions below: 
 

EFR version 3.6 or newer EFR version 3.6 or later will check for updates automatically. If 
a new version of EFR is available, download the latest software 
version from the Elections Canada website. 

EFR version 3.5 To update from EFR version 3.5: 

1. Click the Help menu. 

2. Select “Check for Updates”. If a new version of EFR is 
available, follow the on-screen prompts and download 
the latest software version from the Elections Canada 
website. 

EFR version 3.4 or older  To update from EFR version 3.4 or older, the user must 

download the newest version of EFR. Refer to subsection 2.1, 
Obtain EFR Software, for additional information. 

 
Remember that an active Internet connection is required when checking for 
updates. 

 
Regardless of the version, it is advisable to perform a database backup before 
updating to the latest version of EFR. Refer to subsection 2.8, Backup Database, 
for additional information. 

 
Note: When performing an EFR update, the existing database is saved; this means 

the existing financial returns should not be lost. Backing up data before a 
software update is solely a precautionary measure. 
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2.6 Navigation 
 

The following section introduces EFR’s most commonly used software menus, tabs, 
shortcuts and tips. 

Function Window Details 

Underlined 

fields 

 

Underlined fields are mandatory. EFR does not 

allow users to proceed if the underlined fields 

are left empty. 

Sorting 

 

Users may sort data in ascending or descending 

order by clicking the column title. 

 
 

 

Tabs 

 

Simply click a tab to navigate within EFR but 

remember to save your work first. EFR 

displays the active tab in black text and the 

inactive tabs in white text. 

Details 

button 

 

To modify or update a specific entity 

(contributor, supplier, etc.), click the Details  

button located next to the entity name field. 

Note that any changes made will affect all 

transactions recorded under that name in all 

returns. 

Save 
 

It is important to save your work while 

completing a financial return. Doing so prevents 

loss of data and allows changes to take effect. 

There are three ways to save changes within 

EFR: 

 
1. Click the Save button at the bottom of 

each window. 

2. Press CTRL+S on your keyboard. 

3. Click the File menu and select “Save”. 
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Delete 
 

To delete an entry: 

 
1. Click the row you wish to delete. The 

pointing hand   icon points to the 
row that is selected. 

2. Click “Delete” at the bottom of the 

window. 

3. Click “Yes” to confirm. 

 

Note: Only use the Delete button on the 

Profile tab if you want to delete the 

entire return. The Delete button does 

not clear the profile information. 

Preview 
 

The Preview button is located at the bottom of 

each window and allows users to view the 

current page of the financial return. Changes to 

the financial return must be saved before using 

this function. Users are also given a print 

option. 
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2.7 Utilities 
 

Function Window Details 

Language 

 

To change the software language: 

1. Start EFR. 

2. Click the Utilities menu. 

3. Select “Change Language”. 

All financial returns must be closed before 

attempting to change the software language. 

Passwords 

 

To enable password protection or to change 

software passwords: 

1. Click the Utilities menu. 

2. Select “Enable Password Protection” (to 

password protect your database) or 

“Change Password” (to change the Logon 

or Receipt passwords). 

3. Follow the on-screen prompts. 

Date Format 

 

When entering dates in EFR, use the short 

date format. To confirm or change the date 

format on your computer: 

1. Double-click “My Computer” and click 

“Control Panel”. 

2. Click “Regional and Language Options”. 

3. Under the Regional Options tab, click 

“Customize”. 

4. Click the Date tab and select an option 

from the Short date format drop-down 

menu. 

5. Click “OK”. 
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Export Data 

 

To export data: 

1. Open a financial return. 

2. Click the Utilities menu. 

3. Select “Export Data”. 

4. Make note of the export files folder path. 

5. Specify the sections of the return you 

wish to export by placing checkmark(s) 

in the box(es) that apply. 

6. Click “Export”. 

7. Open the export files folder to retrieve 

the exported data files. 

Import Text 

 

Contributions (for all political entities), 
directed contributions (for leadership 
contestants and registered parties) and 
transfers (for registered parties only) can be 
imported into EFR from a tab-delimited text 
file. To create a text file from a spreadsheet 
application, save the file in Text (Tab 
delimited) format. 

 
The format of the import file is specific. Sample 
files are created on your computer when 
installing EFR. The default location is 
C:\Documents and Settings\All Users\Shared 
Documents\EFR\ for Windows 2000 or 
Windows XP and 
C:\Users\Public\Documents\EFR\ for Windows 
Vista or Windows 7. The files are titled as 
follows: “Contributions.txt”, “transfer.txt” and 
“DirectedContributions.txt”. The sample files 
can be opened using any spreadsheet 
application. Use these templates to record 
contributions, directed contributions and 
transfers. A hard copy of the import templates 
can also be found in Appendix 1 of this guide. 
Once your spreadsheet is ready to be imported, 
save the file in Text (Tab delimited) format. 

 

Refer to subsection 4.1, Entering Inflows: 

Contributions, Directed Contributions and 

Transfers, for additional information. 
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2.8 Backup database 
 

EFR databases should be backed up on a regular basis. Backup prompts are 
presented upon exiting the program; it is advisable to back up your data at 
this time. 

 

 
Performing a backup 

Backups can be initiated at any time during EFR use. 
 

1. Start EFR or, open a financial return if EFR is already running. 

2. Click the Utilities menu. 

3. Select “Backup”. All financial returns are saved in the same folder. The 

default path for the backup folder is: 
 

For Windows 2000 and Windows XP 
C:\Documents and Settings\All Users\Shared Documents\EFR\dbbackup\ 

 

For Windows Vista and Windows 7 
C:\Users\Public\Documents\EFR\dbbackup\ 

 
Note: It is advisable to save a copy of the backup file on a network drive or on 

a removable storage device as EFR data may be lost in the event of a 
hard disk failure on your computer. 

 

 
Restoring a backup 

1. Start EFR. 

2. Click the Utilities menu. 

3. Select “Restore From Backup”. 

4. Select a backup file from the default backup file location. 

○ If the default file path was changed, navigate to the new location you 

have created. 

5. Click “Open”. 
 
Note: The name of the backup file contains the date of the backup. For 

example, efrbackup2013Jan14.zip shows that the backup date was 
January 14, 2013. When restoring a backup file, your current database 
will be replaced with the backup version. All data entered since the last 
backup will be lost. 
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CHAPTER 3 Getting Started 
 

 
 
 
 
 
 

3.1 Creating a new financial return 
 

1. Start EFR. 

2. Click the File menu and select “New Financial Return” or click the New button. 

3. Click “Next”. 

4. Select the type of financial return you wish to create. 

5. Click “Next”. 

6. Select the event for which you need to prepare a return. Before clicking 
“Next”, ensure the event details are correct or edit details if required. If 
preparing an annual return for a party or association, the fiscal year end date 
must be December 31. You can also create a new event by clicking “Add” and 
entering the event details. 

7. Click “Next”. 

8. Choose a political entity and click “Next”. You can also add a new political 

entity by clicking “Add” and entering the new political entity information. 

9. Click “Next”. 

10. For candidates only: Indicate the nomination deposit payee and click “Next”. 

11. Click “Add” to add an agent. 

12. Enter the agent information. 

13. Click “Next”. 

14. Click “Finish”. 
 

 
 
 

3.2 Opening an existing financial return 
 

1. Click the File menu and select “Open Financial Return” or click the Open button 
and select the financial return you wish to open. 

2. Click “OK”. 
 

Note: If only one return is in the EFR database, it will open automatically on EFR startup. 
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3.3 Modifying the political entity profile 
 

1. Open an existing financial return. (Refer to subsection 3.2, Opening an 
Existing Financial Return). 

2. The Profile tab opens by default. 

3. Edit details if necessary. Remember: Underlined fields are mandatory. 

4. Click “Save”. 
 

 
Editing agent details 

 

1. Click the Edit menu and select “Agent Details” or press F2 on your keyboard or 
click the Details button located beside the agent name field. You can 
edit details if necessary, but remember that changes made to the agent’s 
information will also be reflected in other submissions. 

2. Click “OK”. 
 
Note: Remember that pressing the Delete button situated at the bottom of the Profile 

tab deletes the entire return, and not solely the contents of the Profile tab. 
 

 
 
 

3.4 Modifying an event 
 

1. Start EFR and close any open returns. 

2. Click “Utilities”. 

3. Select “Maintain Events”. 

4. Edit the event name(s) and date(s) accordingly. 
 
Note: When modifying an event, note that changes will affect all returns created for 

that event. 
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CHAPTER 4 Managing a Return: 
Recording Transactions 

 

 
 

4.1 Entering inflows 
 
Contributions tab 

 
The following section outlines the various functions of the Contributions tab 

within EFR. The following information applies to the financial returns for 

candidates, nomination contestants, leadership contestants, registered parties 

and registered associations. Open the appropriate financial return and click the 

Contributions tab to begin. 
 

Add a contribution  
 
Applies to: Candidates only. 
 

For monetary contributions only: 
 

1. Click “Add”. 

2. Enter the date of the contribution. 

3. Enter the amount of the monetary contribution, as defined by the Canada 

Elections Act. 

4. Enter the name of the contributor. Always use the drop-down menu to 
search for a contributor’s name before adding a new contributor. The drop-
down menu is accessed by clicking the  beside the contributor name 
field or by pressing the space bar or any letter key on your keyboard 
while the contributor name field is highlighted. If the contributor does not 
exist in your database, click the Details  button or press F2 on your 
keyboard to enter contributor information. Remember that underlined 
fields are mandatory. 

5. Enter the monetary amount given by the contributor. 

6. Enter the advantage received by the contributor, as defined by the 
Income Tax Act. 

7. Enter a description of the advantage received by the contributor, as 

defined by the Income Tax Act. 

8. Click “Save”. 
 
Note: Non-monetary contributions are added in the Expenses tab. By entering the 

commercial value of a good or service in the Expenses tab, EFR will 
automatically add the non-monetary contribution in the Contributions tab. 
Refer to subsection 4.2, Entering Outflows (Expenses Tab), for additional 
information. 

Do not enter a contributor in the database twice. Always search for the 
contributor’s name before entering a new contributor. If the same contributor 
is entered twice but the entries are not identical, EFR will not be able to alert 
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you of potential contribution limit issues. 

Contributions over $200 require the contributor's full name and address. On 
your return, contributions of $200 or less require only the contributor's name, 
but for receipting purposes the full address is required.  
 

Add a contribution  
 
Applies to: Nomination contestants and leadership contestants only. 
 

For monetary contributions only: 
 
 

1. Click “Add”. 

2. Enter the date of the contribution. 

3. Enter the amount of the monetary contribution, as defined by the Canada 

Elections Act. 

4. Enter the name of the contributor. Always use the drop-down menu to 
search for a contributor’s name before adding a new contributor. The drop-
down menu is accessed by clicking the  beside the contributor name 
field or by pressing the space bar or any letter key on your keyboard 
while the contributor name field is highlighted. If the contributor does not 
exist in your database, click the Details  button or press F2 on your 
keyboard to enter contributor information. Remember that underlined 
fields are mandatory. 

5. Click “Ok”. 

6. Click “Save”. 
 
 
Note: Non-monetary contributions are added in the Expenses tab. By entering the 

commercial value of a good or service in the Expenses tab, EFR will 
automatically add the non-monetary contribution in the Contributions tab. 
Refer to subsection 4.2, Entering Outflows (Expenses Tab), for additional 
information. 

 Do not enter a contributor in the database twice. Always search for the 
contributor’s name before entering a new contributor. If the same contributor 
is entered twice but the entries are not identical, EFR will not be able to alert 
you of potential contribution limit issues. 

 
Contributions over $200 require the contributor's full name and address. On 
your return, contributions of $200 or less require only the contributor's name, 
but for receipting purposes the full address is required. 
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Add a contribution  
 
Applies to: Registered parties and registered associations only. 

 

1. Click “Add”. 

2. Enter the date of the contribution. 

3. Select the contribution type, monetary or non-monetary, from the 
Type drop-down  menu. 

4. Enter the amount of the contribution, as defined by the Canada Elections 

Act.  

5. Enter the name of the contributor. Always use the drop-down menu to 
search for a contributor’s name before adding a new contributor. The drop-
down menu is accessed by clicking the  beside the contributor name 
field or by pressing the space bar or any letter key on your keyboard 
while the contributor name field is highlighted. If the contributor does not 
exist in your database, click the Details  button or press F2 on your 
keyboard to enter contributor information. Remember that underlined 
fields are mandatory. 

6. Click “Save”. 

 

If you selected “monetary” in step 3, do the following 
steps: 

7. Enter the monetary amount given by the contributor.  

8. Enter the advantage received by the contributor, as defined by the 
Income Tax Act. 

9. Enter a description of the advantage received by the contributor, as 

defined by the Income Tax Act. 

10. Click “Save”. 

 
Note: Do not enter a contributor in the database twice. Always search for the 

contributor’s name before entering a new contributor. If the same contributor 
is entered twice but the entries are not identical, EFR will not be able to alert 
you of potential contribution limit issues. 

 
Contributions over $200 require the contributor's full name and address. On 
your return, contributions of $200 or less require only the contributor's name, 
but for receipting purposes the full address is required. 
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Add an anonymous contribution of $20 or less                  
 

Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 

registered associations. 
 

1. Click “Add”. 

2. Enter the date of contribution. 

3. Select the contribution type from the Type drop-down menu. 

4. Click the Contributor drop-down menu. 

5. Select “<Anonymous>”. 

6. Click “Select”. 

7. Enter the estimated number of contributors. 

8. Click “Save”. 

 
Note: An anonymous contribution cannot exceed $20. 
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Import contribution data from a text file 
 

Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 
registered associations. 

 

 

Contributions can be imported into EFR from a tab-delimited text file. 
Contribution records must be saved in text format, which can be created from 
a spreadsheet application by simply saving the file in Text (Tab delimited) 
format. 

 

The format of the import file is specific. A sample file is created on your 
computer when EFR is installed. The default location is C:\Documents and 
Settings\All Users\Shared Documents\EFR\ for Windows 2000 or Windows XP 
and C:\Users\Public\Documents\EFR\ for Windows Vista or Windows 7. The file 
is titled “Contributions.txt” and can be opened using any spreadsheet 
application. Use this template to record contributions. A copy of the import 
templates can also be found in Appendix 1 of this guide. Once your 
spreadsheet is ready to be imported, save the file in Text (Tab delimited) 
format. 

 

Note: The date format in your import file must be the same as the short date format 

(e.g. DD/MM/YY) in the regional options on your computer. Refer to 

subsection 2.7, Utilities (Date Format), for additional information. 

 

 To import contribution data from a text file: 

1. Save all changes to your financial return before importing contributions 
from a data file. 

2. Click the Utilities menu. 

3. Select “Import Text File”. The import wizard will open, click “Next”. 

4. Select a reporting event and a political entity. 

5. Click “Next”. 

6. Click “Contributions”. 

7. Click “Next”. 

8. Click the Browse button to locate the import file. 

9. Select the Contributions.txt file and click “Open”. 

10. Click “Next”. 
11. The import wizard will identify the number of entries with errors and 

the number of entries ready to be imported; click “Next”. 

12. Place your cursor in the shaded cells to correct errors. Click “Validate”. 

13. Click “Next”. 

14. Click “Print” to print the list of contributions or click “Next” to proceed. 
15. You may be prompted to select the entries you wish to import. If you wish 

to import all entries, click “Select All” or check the boxes that apply. Click 
“Next”. 

16. Click “Finish”. 
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Validate a contribution  

 
Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 

registered associations. 
 

EFR validates contribution limits, contributor names and mandatory address 
information. In the Contributions tab: 

 

1. Click “Validate”. 

2. Click “OK”. 

3. Review all validation messages. 
 

Add a returned contribution  

 
Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 

registered associations. 
 

1. Click the contribution you wish to return in the Contributions tab.  

2. Click “Add Returned Contributions”. 

3. Check the name in the title bar to verify that you are returning the 
appropriate contribution. 

4. Enter the date the contribution was returned. 

5. Enter the amount returned. 

6. Click the Returned To drop-down menu. 

7. Select either “Contributor” or “Office of CEO”. 

8. Click “Save”. 

9. Click “Close”. 

10. In the case of candidates, nomination contestants, and leadership 
contestants, do not forget to also record the return of a contribution 
under the Expenses tab. Refer to subsection 4.2, Entering Outflows 
(Expenses Tab), for additional information. 

 

View a returned contribution  

 
Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 

registered associations. 
 

1. Click the row you wish to view.  

2. Click “View Returned Contributions”. 

3. You may add, edit or delete returned contributions from this window. 

4. Click “Save”. 

5. Click “Close”. 
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Print a contribution receipt  

 
Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 

registered associations. 
 

1. Place a checkmark in the Print Receipt checkbox(es) you wish to print. 

2. Click “Print Contribution Receipt”. The Process Receipts window will open. 

3. Users may select the receipt type (“Draft” or “One copy per page”) or leave 
the option unselected. If unselected, EFR will print all receipt copies on 
one page. 

4. If you wish to preview the receipts before printing, click “Preview”; 
otherwise, click “Print”. Users printing receipts valid for tax purposes will 
be asked to enter a password before previewing and printing. The 
password for printing receipts valid for tax purposes is “ecdollar”. EFR will 
also produce non-tax receipts for contributions not eligible for tax credits. 

 
Note: For candidates, if you use EFR to produce your receipts, you do not need to 

obtain paper form official receipts for tax purposes from the returning officer. 
By using EFR to print your contributions receipts, you can avoid the need to 
return them by the one-month deadline.  



Electronic Financial Return User Guide 

24 
 

EC 20206 

 

 

Loans tab 

 
The following section outlines the various functions of the Loans tab within 

EFR. The following information applies to candidates, nomination contestants, 

leadership contestants, registered parties and registered associations. Open 

the appropriate financial return and click the Loans tab to begin. 
 

Add a loan  

 
Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 

registered associations. 
 

1. Click “Add Loan”. 

2. Enter the date the proceeds of the loan were received. 

3. Enter the name of the lender. Always use the drop-down menu to search 

for a name before adding a new lender. The drop-down menu is accessed 
by clicking the beside the lender name field or by pressing the space 
bar or any letter key on your keyboard while the lender name field is 
highlighted. If the lender does not exist in your database, click the Details 

button or press F2 on your keyboard to enter lender information. 
Remember that underlined fields are mandatory. 

4. Click “OK”. 

5. Enter the name of the guarantor, if applicable. Always use the drop-down 
menu to search for a name before adding a new guarantor. The drop-
down menu is accessed by clicking the beside the guarantor name 
field or by pressing the space bar or any letter key on your keyboard while 
the guarantor name field is highlighted. If the guarantor does not exist in 
your database, click the Details button or press F3 on your 
keyboard to enter guarantor information. Remember that underlined 
fields are mandatory. 

6. Click “OK”. 

7. Enter the interest rate. 

8. Enter the principal of the loan. 

9. Click “Save”. 
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Add overdraft/line of credit 
 

Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 
registered associations. 

 

1. Click “Add Overdraft / Line of Credit”. 

2. Enter the name of the financial institution. Always use the drop-down 

menu to search for an institution before adding a new one. The drop-
down menu is accessed by clicking the beside the financial institution 
name field or by pressing the space bar or any letter key on your 
keyboard while the financial institution name field is highlighted. If the 
institution does not exist in your database, click the Details button 
or press F4 on your keyboard to enter institution information. Remember 
that underlined fields are mandatory. 

3. Click “OK”. 

4. Enter the interest rate. 

5. Enter the maximum amount owed at any given time. 

6. Click “Save”. 
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Transfers In tab 

The following section outlines the various functions of the Transfers In tab 
within EFR. The following information applies to candidates, nomination 
contestants, leadership contestants, registered parties and registered 
associations. Open the appropriate financial return and click the Transfers In 
tab to begin. 

Note: For candidates, leadership contestants and nomination contestants, non-

monetary transfers in are entered through the Expenses tab. However, users 

may view non-monetary transfers in the Transfers In tab. All edits to the non- 

monetary transfers must be conducted through the Expenses tab. Refer to 

subsection 4.2, Entering Outflows (Expenses Tab), for additional information. 

Add a transfer in  

Applies to: Candidates and nomination contestants only. 
 

1. Click “Add”. 

2. Enter the date the transfer was received. 

3. Enter the name of the political entity. Always use the drop-down menu to 
search for an entity before adding a new one. The drop-down menu is 
accessed by clicking the beside the political entity name field or by 
pressing the space bar or any letter key on your keyboard while the 
political entity name field is highlighted. If the entity does not exist in 
your database, click the Details button or press F2 on your 
keyboard to enter political entity information. Remember that underlined 
fields are mandatory. 

4. Click “OK”. 

5. Enter the amount. 

6. Click “Save”. 
 

Add a transfer in 

Applies to: Registered parties and registered associations only. 
 

1. Click “Add”. 

2. Enter the date the transfer was received. 

3. Enter the name of the political entity. Always use the drop-down menu to 
search for an entity before adding a new one. The drop-down menu is 
accessed by clicking the beside the political entity name field or by 
pressing the space bar or any letter key on your keyboard while the 
political entity name field is highlighted. If the entity does not exist in 
your database, click the Details button or press F2 on your 
keyboard to enter political entity information. Remember that underlined 
fields are mandatory. 

4. Click “OK”. 

5. Click the Type drop-down menu. 

6. Select either “Monetary” or “Non-Monetary”. 

7. Enter the amount. 

8. Click “Save”. 
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Import “transfers in” data from a text file 
 

Applies to: Registered parties only. 

 

 
 

“Transfers In” data can be imported into EFR from a tab-delimited text file. 
Transfer records must be saved in text format, which can be created from a 
spreadsheet application by simply saving the file in Text (Tab delimited) format. 

 
The import file is in a specific format. A sample file is created on your computer 
when installing EFR. The default location is C:\Documents and Settings\All 
Users\Shared Documents\EFR\ for Windows 2000 or Windows XP and 
C:\Users\Public\Documents\EFR\ for Windows Vista or Windows 7. The file is 
titled “transfer.txt” and can be opened using any spreadsheet application. Use 
this template to record transfers. A copy of the import templates can also be 
found in Appendix 1 of this guide. Once your spreadsheet is ready to be 
imported, save the file in Text (Tab delimited) format. 

 

Note: The date format in your import file must be the same as the short date format 

DD/MM/YY) in the regional options on your computer. Refer to subsection 2.7, 

Utilities (Date Format), for additional information. 
 

1. Save all changes to your financial return before importing transfers 
received from a data file. 

2. Click the Utilities menu. 

3. Select “Import Text File”. The import wizard will open, click “Next”. 

4. Select a reporting event and a political entity. 

5. Click “Next”. 

6. Click “Transfers In”. 

7. Click “Next”. 

8. Click the Browse button to locate the import file. 

9. Select the transfer.txt file and click “Open”. 

10. Click “Next”. 

11. The import wizard will identify the number of entries with errors and 
the number of entries ready to be imported, click “Next”. 

12. Place your cursor in the shaded cells to correct errors. Click “Validate”. 

13. Click “Next”. 

14. Click “Print” to print the list of transfers in or click “Next” to proceed. 

15. You may be prompted to select the entries you wish to import. If you wish 
to import all entries, click “Select All” or check the boxes that apply. Click 
“Next”. 

16. Click “Finish”. 
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Cash Inflows tab 

 
The following section outlines the various functions of the Cash Inflows tab 

within EFR. The following information applies to candidates, nomination 

contestants, and leadership contestants only. Open the appropriate financial 

return and click the Cash Inflows tab to begin. 
 

Add a cash inflow  

Applies to: Candidates, nomination contestants and leadership contestants only. 
 

1. Click “Add”. 

2. Enter the date the funds were received. 

3. Enter a description. For example, you can enter the name of the entity or 

individual from which the funds came from. 

4. Select an option from the Inflow Type drop-down menu. 

5. Enter the inflow amount. 

6. Click “Save”. 
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Directed Contributions tab 
 

The following section outlines the various functions of the Directed 

Contributions tab within EFR. The following information applies to leadership 

contestants and registered parties only. Open the appropriate financial return 

and click the Directed Contributions tab to begin. 
 

Add a directed contribution  

Applies to: Registered parties only. 
 

1. Click “Add”. 

2. Enter the date the directed contribution was received by the party. 

3. Enter the name of the contributor. Always use the drop-down menu to 
search for a contributor before adding a new contributor. The drop-down 
menu is accessed by clicking the  beside the contributor name field or by 
pressing the space bar or any letter key on your keyboard while the 
contributor name field is highlighted. If the contributor does not exist in 
your database, click the Details  button or press F2 on your keyboard to 
enter contributor information. Remember that underlined fields are 
mandatory. 

4. Enter the name of the leadership contestant. Always use the drop-down 
menu to search for a leadership contestant before adding a new 
contestant. The drop-down menu is accessed by clicking the  beside the 
leadership contestant name field or by pressing the space bar or any letter 
key on your keyboard while the leadership contestant name field is 
highlighted. If the contestant does not exist in your database, click the 
Details  button or press F3 on your keyboard to enter contestant 
information. Remember that underlined fields are mandatory. 

5. Enter the total contribution amount received by the party. 

6. Enter the directed amount of the contribution. 

7. Enter the amount of the contribution that was transferred to the leadership 

contestant. 

8. Enter the monetary amount given by the contributor. 

9. Enter the advantage received by the contributor as defined by the Income 

Tax Act. 

10. Enter a description of the advantage received by the contributor as defined 

by the Income Tax Act. 

11. Click “Save”. 
 

Add a directed contribution  

Applies to: Leadership contestants only. 
 

1. Click “Add”. 

2. Enter the date the directed contribution was received by the party. 

3. Enter the name of the contributor. Always use the drop-down menu to 

search for a contributor’s name before adding a new contributor. The drop-
down menu is accessed by clicking the  beside the contributor name field 
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or by pressing the space bar or any letter key on your keyboard while the 
contributor name field is highlighted. If the contributor does not exist in 
your database, click the Details  button or press F2 on your keyboard to 
enter contributor information. Remember that underlined fields are 
mandatory. 

4. Enter the total contribution amount received by the party. 

5. Enter the amount of the contribution that was directed to the leadership 

contestant. 

6. Enter the amount of the contribution that was transferred to the leadership 

contestant. 

7. Enter the date the contribution is transferred from the party to the 

leadership contestant. 

8. Click “Save”. 

 

Import “directed contributions” data from a text file 

Applies to: Leadership contestants and registered parties only. 

 

Directed contributions can be imported into EFR from a tab-delimited text file. 
Directed contribution records must be saved in text format, which can be 
created from a spreadsheet application by simply saving the file in Text (Tab 
delimited) format. 

 

The format of the import file is specific. A sample file is created on your 
computer when installing EFR. The default location is C:\Documents and 
Settings\All Users\Shared Documents\EFR\ for Windows 2000 or Windows XP 
and C:\Users\Public\Documents\EFR\ for Windows Vista or Windows 7. The file 
is titled “DirectedContributions.txt” and can be opened using any spreadsheet 
application. Use this template to record directed contributions. A copy of the 
import templates can also be found in Appendix 1 of this guide. Once your 
spreadsheet is ready to be imported, save the file in Text (Tab delimited) 
format. 

 

Note: The date format in your import file must be the same as the short date format 

(e.g. DD/MM/YY) in the regional options on your computer. Refer to 

subsection 2.7, Utilities (Date Format), for additional information. 

1. Save all changes to your financial return before importing contributions 
from a data file. 

2. Click the Utilities menu. 

3. Select “Import Text File”. The import wizard will open, click “Next”. 

4. Select a reporting event and a political entity. 

5. Click “Next”. 

6. Click “Directed Contributions”. 

7. Click “Next”. 
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8. Click the Browse button to locate the import file. 

9. Select the “DirectedContributions.txt” file and click “Open”. 

10. Click “Next”. 
11. The import wizard will identify the number of entries with errors and the 

number of entries ready to be imported, click “Next”. 

12. Place your cursor in the shaded cells to correct errors. Click “Validate”. 

13. Click “Next”. 

14. Click “Print” to print the list of directed contributions or click “Next” to 

proceed. 
15. You may be prompted to select the entries you wish to import. If you wish 

to import all entries, click “Select All” or check the boxes that apply. Click 
“Next”. 

16. Click “Finish”. 
 

Validate a directed contribution  

Applies to: Leadership contestants and registered parties only. 
 

EFR validates contribution limits for leadership contestants, contributor names 
and mandatory address information. 

 

1. Click “Validate”. 

2. Click “OK”. 

3. Review all validation messages. 
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4.2 Entering outflows 
 
 
Expenses tab 

 
The following section outlines the various functions of the Expenses tab within 

EFR. The following information applies to candidates, nomination contestants 

and leadership contestants only. Open the appropriate financial return and click 

the Expenses tab to begin. 
 

Add an expense  

Applies to: Candidates, nomination contestants, and leadership contestants only. 
 

1. Click “Add”. 

2. Enter the invoice date. 

3. Enter the name of the supplier. Always use the drop-down menu to search 

for a name before adding a new supplier. The drop-down menu is 
accessed by clicking the beside the supplier name field or by 
pressing the space bar or any letter key on your keyboard while the 
supplier name field is highlighted. If the supplier does not exist in your 
database, click the Details button or press F2 on your keyboard to 
enter supplier information. Remember that underlined fields are 
mandatory. 

4. Click “OK”. 

5. Enter the invoice number. Enter the cheque and voucher numbers if 

applicable. 

6. Enter the expense as “Amount Paid”, “Discount”, “Agreed Unpaid 
Claim” or “Disputed Unpaid Claim” (you may split the expense 
accordingly). 

7. Click the Expense Category tab on the top left hand corner of the screen. 

8. Enter the expense amount per sub-category. 

9. Click the Sub Category drop-down menu, or press F3 on your 
keyboard to allocate the expense amount to a category. 

10. Select the category that best applies to your expense and click “Select”. 

You may allocate the expense amount to more than one expense 
category by clicking “Add” and repeating steps 8 to 10. 

11. Continue to add and allocate your expenses until the expenses are 

balanced. This occurs when the difference between the invoice amount and 

expenses allocated is $0. 

12. Click “Save”. 
 

Note: See Appendix 2 for an example. 
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Transfers Out tab 

 
The following section outlines the various functions of the Transfers Out tab 

within EFR. The following information applies to registered parties and 

registered associations only. Open the appropriate financial return and click the 

Transfers Out tab to begin. 
 

Add a transfer out  

Applies to: Registered parties and registered associations only. 
 

1. Click “Add”. 

2. Enter the date. 

3. Enter the name of the political entity. Always use the drop-down menu to 

search for an entity before adding a new one. The drop-down menu is 
accessed by clicking the beside the political entity name field or by 
pressing the space bar or any letter key on your keyboard while the 
political entity name field is highlighted. If the entity does not exist in 
your database, click the Details button or press F2 on your 
keyboard to enter political entity information. Remember that underlined 
fields are mandatory. 

4. Click “OK”. 

5. Select either “Monetary” or “Non-Monetary” from the Type drop-down 

menu. 

6. Enter the transferred amount. 

7. Click “Save”. 
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Import “transfers out” data from a text file 
 

Applies to: Registered parties only. 
 

 

 
 

Transfers can be imported into EFR from a tab-delimited text file. Transfer 
records must be saved in text format, which can be created from a spreadsheet 
application by simply saving the file in Text (Tab delimited) format. 

 
The format of the import file is specific. A sample file is created on your 
computer when installing EFR. The default location is C:\Documents and 
Settings\All Users\Shared Documents\EFR\ for Windows 2000 or Windows XP 
and C:\Users\Public\Documents\EFR\ for Windows Vista or Windows 7. The file is 
titled “transfer.txt” and can be opened using any spreadsheet application. Use 
this template to record transfers. A copy of the import templates can also be 
found in Appendix 1 of this guide. Once your spreadsheet is ready to be 
imported, save the file in Text (Tab delimited) format. 

 

Note: The date format in your import file must be the same as the short date format 

(e.g. DD/MM/YY) in the regional options on your computer. Refer to 

subsection 2.7, Utilities (Date Format), for additional information. 
 

1. Save all changes to your financial return before importing transfers 
from a data file. 

2. Click the Utilities menu. 

3. Select “Import Text File.” The import wizard will open, click “Next”. 

4. Select a reporting event and a political entity. 

5. Click “Next”. 

6. Click “Transfers Out”. 

7. Click “Next”. 

8. Click the Browse button to locate the import file. 

9. Click transfer.txt file and click “Open”. 

10. Click “Next”. 

11. The import wizard will identify the number of entries with errors and 

the number of entries ready to be imported, click “Next”. 

12. Place your cursor in the shaded cells to correct errors. Click “Validate”. 

13. Click “Next”. 

14. Click “Print” to print the list of transfers out or click “Next” to proceed. 

15. You may be prompted to select the entries you wish to import. If you wish 

to import all entries, click “Select All” or check the boxes that apply. Click 
“Next”. 

16. Click “Finish”. 
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Unpaid Claims tab 

 
The following section outlines the various functions of the Unpaid Claims tab 

within EFR. The following information applies to annual returns for registered 

parties and registered associations only. Open the appropriate financial return 

and click the Unpaid Claims tab to begin. 
 

Add an unpaid claim  

Applies to: Registered parties and registered associations only. 
 

1. Click “Add”. 

2. Enter the date. 

3. Enter the name of the supplier. Always use the drop-down menu to search 

for a name before adding a new supplier. The drop-down menu is 
accessed by clicking the  beside the supplier name field or by 
pressing the space bar or any letter key on your keyboard while the 
supplier name field is highlighted. If the supplier does not exist in your 
database, click the Details button or press F2 on your keyboard to 
enter supplier information. Remember that underlined fields are 
mandatory. 

4. Click “OK”. 

5. Enter the agreed unpaid claim and the disputed unpaid claim if applicable. 

6. Click “Save”. 
 

 
By-election Expenses tab 

 
The following section outlines the various functions of the By-election Expenses 

tab within EFR. The following information applies to registered parties only. 

Open the appropriate financial return and click the By-election Expenses tab to 

begin. 
 

Add a by-election expense  

Applies to: Registered parties only (for the Registered Party Financial Transactions Return). 
 

1. Click “Add”. 

2. Enter the date. 

3. Select an option from the Electoral District drop-down menu. 

4. Select an option from the Category and Sub-category drop-down 

menu. 

5. Enter the expense as “Amount Paid”, “Discount”, “Agreed Unpaid 
Claim” or “Disputed Unpaid Claim” (you may split the expense 
accordingly). 

6. Click “Save”. 
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Limitation of Election Expenses tab 

The following section outlines the various functions of the Limitation of 

Election Expenses tab within EFR. The following information applies to 

registered parties only. Open the appropriate financial return and click the 

Limitation of Election Expenses tab to begin. 
 

Add a limitation of election expenses 
 

Applies to: Registered parties only (for the Registered Party Return in Respect of General Election 
Expenses). 

 
 

 

1. Enter the amount of the indexed limit of election expenses. 

2. Click “Save”. 
 

 

General Election Expenses tab 

 
The following section outlines the various functions of the General Election 

Expenses tab within EFR. Open the appropriate financial return and click the 

General Election Expenses tab to begin. 
 

Add a general election expense  

Applies to: Registered parties only (for the Registered Party Return in Respect of General Election 
Expenses). 

 

1. Click “Add”. 

2. Select the appropriate expense from the Category drop-down menu. 

3. Enter the expense as “Amount Paid”, “Discount”, “Agreed Unpaid 

Claim” or “Disputed Unpaid Claim” (you may split the expense 
accordingly). 

4. Click “Save”. 
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4.3 Financial summary 
 
 
Financial Summary tab 

 
The following section defines the fields of the Financial Summary tab within EFR. The 

following information applies to candidates, nomination contestants and leadership 

contestants only. Open the appropriate financial return and click the Financial Summary 

tab to begin. 

 

 

Submission date 

 

Enter the date up to which you have reported all 

campaign transactions in your return. 

 

Permitted election expense 

Applies to: Candidates and nomination contestants only. 

 
Enter the final limit of election expenses or 
nomination campaign expenses for your electoral 
district. 

 

Note: Elections Canada provides this limit to you by mail 

and it is also available on the Elections Canada 

website. 

 

Bank credits and bank deposits 
 

Enter the total bank debits and total bank credits 
to your campaign bank account using your bank 
statements. 

 

Note: Most financial institutions provide a summary at 

the bottom of each monthly bank statement 

indicating the total debits and credits for that 

month. 

 

Outstanding Cheques 
 

Enter the total dollar amount of cheques that have 

been issued and are reported in your campaign return, 

but have not yet cleared your bank account.  
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Deposits in transit 

 

Enter the total dollar amount of all cash inflows 

reported in your return that have not yet been credited 

to your bank account. 

 

Save and validate 
 

1. Click “Save”. 
2. Click “Validate”. 

 
The cash inflows less the cash outflows reported 
in your return should equal your bank account 
balance less any outstanding cheques plus 
deposits in transit. 
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Optional Expenses tab 

 
The following section outlines the various functions of the Optional Expenses tab 

within EFR. The following information applies to registered parties and 

registered associations only. Open the appropriate financial return and click the 

Optional Expenses tab to begin. 
 

Add an optional expense  

Applies to: Registered parties and registered associations only. 
 

1. Click “Add”. 

2. Enter the date. 

3. Select an option from the Category drop-down menu.  

4. Enter the amount paid. 

5. Click “Save”. 
 

Note: The information entered in this tab does not form part of the return. The tab is 
included as a tool to assist in tracking expenses against budgeted amounts. 
Refer to the Budget Tool tab description below. 

 

 
Budget Tool tab 

 

Applies to: Candidates, nomination contestants, leadership contestants, registered parties and 
registered associations. 

 
The budget tool is optional. It allows users to manage their expenses. 
Expenses entered in the Optional Expenses tab (registered parties and 
registered associations only) or the Expenses tab (candidates, nomination 
contestants and leadership contestants only) will be automatically compared 
to budgeted amounts in the Budget Tool tab. This information does not form 
part of the return. 

 

 
Financial Statement tab 

 

Applies to: Registered associations only. 

 
Part 4 of the financial return consists of a statement of revenues, expenses, 
assets and liabilities. 

 

1. Click any field. 

2. Enter dollar amounts where applicable. 

3. Click “Save”. 

4. Click “Validation”. If the statements do not reconcile (total assets do not 

equal total liabilities and net assets), EFR will advise the user to make 
corrections before submitting the financial return. 

 
Note: This section requires manual data entry directly from the financial 

statements of the registered associations. 

  



Electronic Financial Return User Guide 

40 
 

EC 20206 

 

 

 

This page is intentionally left blank. 

 



EC 20206 41 
 

 

 

CHAPTER 5 Electronic Submission 
 

 
 
 
 
 
 

5.1 Submitting your return to Elections Canada 
 

1. Start EFR. 

2. Open a financial return (refer to subsection 3.2, Opening an Existing 
Financial Return). 

3. Click the Reports menu. 

4. Select “Elections Canada”. 

5. Select the financial return you wish to submit. 

6. Click “Create EC Submission File”. 

7. Once the EC Submission file has been created, a window will appear 
informing you of the location of the submission file. Attach the submission 
file to an-email and send to efr-rfe@elections.ca.  

 

Note the submission file location: 
 

For Windows 2000/XP 
C:\Documents and Settings\All Users\Shared Documents\EFR\frms\ 

 

For Windows Vista/7 
C:\Users\Public\Documents\EFR\frms\ 

 
Note: Remember to send a signed paper copy to Elections Canada by mail, courier or 

fax by the filing deadline. 
 
 
 

5.2 Printing your financial return 
 

1. Start EFR. 

2. Open a financial return (refer to subsection 3.2, Opening an Existing 

Financial Return). 

3. Click “Reports”. 

4. Select “Elections Canada”. 

5. Select the financial return you wish to print. 

6. Click “Select all”. 

7. If you have legal size paper in your printer click “Print” otherwise click 

“Save to PDF”, after which you can open and print your return using the 
PDF reader software of your choice. 
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CHAPTER 6 Troubleshooting Tips 
 

 
 
 
 
 
 

6.1. EFR will not start 
 

The user must have administrator privileges on his or her computer in order to run 
EFR. To change the user account settings to “Administrator”, follow the directions 
below: 

 

1. Right-click the EFR software icon. 

2. Select “Run as”. 

3. Select “Administrator”. 

4. Click “OK”. 

5. Double-click the EFR software icon to open the program. 
 

OR 

 
1. Right-click the EFR software icon. 

2. Select “Properties”. 

3. Click “Compatibility”. 

4. Select “Run this program as an administrator”. 

5. Click “Apply”. 

6. Click “OK”. 

7. Double-click the EFR software icon to open the program. 
 

 
 
 

6.2. EFR will not open a financial return 
 

Older versions of EFR will not open databases created with newer version of the 
application. To resolve the problem, download and install the latest version of EFR. 
Refer to subsection 2.1, Obtain EFR Software, and subsection 2.3, Install EFR, for 
additional information. 

 

 
 
 

6.3. Contributor names cannot be deleted from the database 
 

A contributor cannot be deleted from the EFR database once it has been added. 
EFR manages multiple returns in the same database. It is therefore likely that a 
contributor is linked to a transaction recorded in a previous return. 
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6.4. Data export error: Path is empty for the export files folder 
 

The export files folder path is empty if the user did not enter the event name in the 
same language that EFR is currently running in. To resolve the problem, follow the 
following steps: 

 

1. Start EFR. 

2. Click the Utilities menu. 

3. Select “Maintain Events”. 

4. Enter the missing event name(s). Ensure both the French and English name 

field(s) are complete. 

5. Click “Save”. Future attempts to export data should be successful. 
 

 
 
 

6.5. Firewall or antivirus software prevents EFR use 
 

To prevent a firewall or antivirus software from prohibiting EFR use, users must 
unblock or allow EFR use. To resolve the problem: 

 

1. Open your firewall or antivirus software. 

2. Add an exception for EFR. 
 

OR 
 

1. When prompted by your firewall or antivirus software, select “Allow” to enable 
EFR to install or to run on your computer. 
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Appendix 
 
 
 
 
 
 

This section contains useful information on using the EFR software. The contents 
of this section are: 

 

1. Importing templates 

2. Adding an expense 
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1. Importing templates 

 
Contributions, transfers and directed contributions can be imported into EFR from a tab-delimited text file. The import files 
must be saved in text format, which can be created from a spreadsheet application by simply saving the file in Text (Tab 
delimited) format. Use the following templates to record contributions, transfers and directed contributions. Soft copies of the 
templates can also be found on your computer in the following directory: C:\Documents and Settings\All Users\Shared 
Documents\EFR\ for Windows 2000 or Windows XP and C:\Users\Public\Documents\EFR\ for Windows Vista or Windows 7. 

 

Contributions 
 

Contribution 
Date 

Contribution 
Per CEA 

Contributor 

Type
1
 Last Name 

First 
Name Initial 

Street 

# 

Street 
Name 

Suite # 

/ Apt City Province
2

 
Postal 
Code 

Estimated # 
of 
Contributors 

Monetary 
Amount 
Given 

Advantage 
Received Per 
ITA 

Advantage 
Description 

12/12/2013 150 A Dumont Ronald Jr 15 Blois  Gatineau QC J8R8U9  150   

13/12/2013 1200 A Page Jessica  17 Bank St.  Ottawa ON K1A4R5  1200 200 Name the benefit 

05/06/2013 800 A 
Anonymous 

/anonyme 
        200    

 

Transfers (applicable to registered parties only) 
 

 

Transfer Date 

 

Transfer Amount 

 

Type of transfer
3

 
Political Entity Type

4
 Electoral District Code 

 

Family Name 

 

Given Name 
 

Initial 

15/03/2013 15400 M 1 24001 Langlois François JR 

 
24/02/2013 

 
1233 

 
NM 

 
5 

 
12001 

Association Libéral de St 

Lambert 
  

01/12/2013 1522 M 3 35102 Brown John R 

 

Directed contributions (applicable to registered parties and leadership contestants only) 
 

 

Last 
Name 

 

First 
Name 

 

Initial 

 

Street # 

 

Street 
Name 

 

Suite # 

/ Apt 

 

City 

 

Province 

 

Postal 
Code 

 
Party 
Received 
Date 

 

Contribution 
Amount 

 

Directed 
Amount 

 

Transferred 
Amount 

Leadership 
Contest 
Received 
Date 

Monetary 
Amount 
Given 

Advantage 
Received 
Per ITA 

Advantage 
Description 

Noble Martin  47 Victoria 8 Vancouver BC K8J9T6 12/12/2013 1000 1000 1000 18/12/2013 1000   

Beaumont Natalie S 56 Lewiston  Calgary AB P1B5G9 21/12/2013 1100 900 750 24/12/2013 1100   

Lombard Sarah J 14 Bay View 14 Halifax NS V8T6G9 04/03/2013 750 750 750 07/03/2013 750 350 
Name the 

benefit 

 
 

 
1 

 

 
A - Individuals  
B - Corporations 
C - Trade Unions 

 

 
2 

NL - Newfoundland and Labrador 
NS - Nova Scotia 
PE - Prince Edward Island 
NB - New Brunswick 
QC - Quebec 
ON - Ontario 
MB - Manitoba 

SK - Saskatchewan 
AB - Alberta 
BC - British Columbia 
NT - Northwest Territories 
YT - Yukon 
NU - Nunavut 
NA - None 

 

 
3 

 
 
NM - Non-monetary 
M - Monetary 

 

 
4 

 
1 - Candidate 
2 - Leadership Contestant 
3 - Nomination Contestant 
5 - Registered Association 

 
 



4
6
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2. Adding an expense 

 
This screen capture refers to the Entering Outflows section of this manual. 
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